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************************************************************************
The WinMACCS Version 3.10 distribution consists of the following files:
************************************************************************
History of MACCS.rtf

MACCS History

History of WinMACCS.rtf

WinMACCS History

Tutorials.rtf

most recent tutorials to be used

Readme.rtf

this file

\Documentation\

directory containing WinMACCS, MACCS, and MACCS
documentation as follows

WinMACCS Model User Manual.pdf
WinMACCS User's Guide consistent with version 3.4
WinMACCS User Specified Dose Conversion Factors.pdf
describes how to change dose conversion factors within
WinMACCS
WinMACCS Graphical Integration of SUMPOP.pdf
describes how to enter very flexible populations for each
evacuation cohort
WinMACCS 3.9 Improvements.pdf
describes improvements made to version 3.9.0
WinMACCS Version 3.10.0.pdf
describes improvements made to version 3.10.0
Code Manual for MACCS2 Vol 1.pdf
NUREG/CR-6613, Vol 1 Code Manual for MACCS2: Volume
1 Users Guide, 1998. Superseded by WinMACCS Model User
Manual.
Code Manual for MACCS2 Vol 2.pdf
NUREG/CR-6613, Vol. 2 Code Manual for MACCS2:

Preprocessor Codes COMIDA2, FGRDCF, IDCF2, 1998
MACCS Model Description.pdf
NUREG/CR-4691, MELCOR Accident Consequence Code
System, 1990, Superseded by WinMACCS Model User Manual
\DCF and COMIDA2 Files\

this directory contains dose conversion factor (DCF) files and
their associated COMIDA2 binary files. The COMIDA2 binary
files were created by running the COMIDA2 preprocessor with
each of the DCF files as input. These files are copied as part of
the installation procedure into the Program Files
(x86)\WinMACCS folder by default.

\Linear NoThreshold\

a subdirectory containing DCF and COMIDA2 files used
when running the LNT dose-response model

\Dosfac2\

contains a DCF file created by preprocessor DOSFAC2 based
on ICRP-26, ICRP-30, and DOE/EH-OO70. Also contains
associated COMIDA2 file. This is included to recreate sample
problems distributed with MACCS2 1.13.1. These files are
used in sample problem A: IN1A.INP, IN2A.INP,
IN3A_N.INP.

\Fgr-11 -12\

Contains DCF file created by preprocessor FGRDCF based on
FGR-11 and -12. Also contains associated COMIDA2 file.
This is included to recreate sample problems distributed with
MACCS2 1.13.1. Files are used in sample problem F:
IN1F_BIN.INP, IN2F_BIN.INP, IN3F.INP.

\Fgr-13\

recommended DCF and COMIDA2 files. Files are created to be
consistent with Federal Guidance Report No.13 CD
Supplement, EP 402-C-99-001, Rev.1, April 2002.

\Threshold\

a subdirectory containing DCF and COMIDA2 files to be used
when running the threshold or the piecewise linear
dose-response model

************************************************************************
Sample problems:
************************************************************************
The following sample projects are included with the distribution. These files can also be
extracted from a zip file, WinMACCS Samples.zip, which can be downloaded separately from the
setup.exe download.
These files will be installed in the folder \WinMACCS\Samples\ located in the My Documents

folder when WinMACCS is installed.
Each project has an \Output\ folder. When WinMACCS is executed, the MACCS output file,
named model1.out, is placed in this directory. For comparison purposes, a file called project.out
in each project directory contains the MACCS results from SNL. This file can be used to compare
with model1.out to ensure that the program is working properly on the user's computer.
NRC Sample Problems\Point Estimates LNT
Sample problem highlighting NRC current practices using linear no threshold
(LNT) dose-response model. The origin of this sample problem is Sample
Problem A from the original MACCS2 release version 1.12. However, a number of
economic and other parameters have been updated to be more current. In particular,
a number of model parameters have been replaced by median values from a set of
NRC/CEC volumes that explore expert opinions of values used in consequence
analysis.
NRC Sample Problems \Point Estimates Threshold
Similar to sample problem, Point Estimates LNT, but the threshold dose-response
model is used. The Health Physics Society (HPS) has stated that "below 5 to 10 rem
(which includes occupational and environmental exposures), risks of health effects
are either too small to be observed or are nonexistent." The model and values used
are based on this HPS position statement.
NRC Sample Problems \Sampled Values LNT
Similar to Point Estimates LNT. However, instead of a deterministic calculation,
Latin Hypercube sampling is used to sample uncertain input values. Model value
distributions are based on expert elicitation (see NUREG/CR-6526). Because of
the large number of output files created, only one of the 200 output sets is included.
DOE Sample Problems\General Public ICRP-72
Inventories are 1 Currie each for the following nuclides: Pu-238, -239, -240, -241,
and Am-241. Problem runs ATMOS and EARLY in a cyclical fashion to simulate
ATMOS change cards. ICRP-72 is used to model the public dose.
DOE Sample Problems \Worker Dose ICRP-68
Inventories are 1 Currie each for the following nuclides: Pu-238, -239, -240, -241,
and Am-241. Problem runs ATMOS and EARLY in a cyclical fashion to simulate
ATMOS change cards. ICRP-68 is used to model the worker dose.
************************************************************************
Environment
************************************************************************
Installation has been tested under Windows 7 and Windows 8. If it is necessary to install under
Windows XP and an older version of WinMACCS has not been installed, it is suggested that
WinMACCS 3.7 is installed followed by an installation of WinMACCS 3.10. This will ensure
that all external components to WinMACCS have been correctly installed.
If using Windows 8, the WinMACCS executable is available in Start menu. However, the
document folder is not available from the Start menu. The documents listed can be accessed
through the Program Files (X86)/WinMACCS folder.

Minimum display settings are 1024 by 768.
************************************************************************
Installation of WinMACCS from Start Menu
************************************************************************
Run Setup.exe from the Start menu to install WinMACCS.
Click on the Start button.
Select Run.
Click on the Browse button and locate Setup.exe
Click OK. WinMACCS will install.
Enter a password when prompted. The user must request a password from SNL.
************************************************************************
WinMACCS from Windows Start Menu
************************************************************************
After you install WinMACCS the following is added to the WinMACCS group. These can be
accessed from the Start menu.
1.
2.
3.
4.

History of MACCS: History of public releases of MACCS
History of WinMACCS: History of public releases of WinMACCS
readme: This file.
Tutorials: Recommended reading for new users. Tutorial One will show user how to
modify model parameters and run a sample problem. Tutorial Two is helpful to learn how
to convert existing MACCS input sets into a WinMACCS project. It is assumed that file
WinMACCS_Samples.zip has been downloaded and unzipped on drive C:\.
5. Uninstall WinMACCS: Removes or repairs the WinMACCS installation. (you must use
this or the Add/Remove programs option from the Control Panel to remove WinMACCS
correctly).
6. WinMACCS: Run the windows interface to MACCS. After opening the application,
either create a new project or open an existing project by using the menu selections
File->New or File->Open.
7. Documentation: Folder containing WinMACCS, MACCS and preprocessor
documentation.
************************************************************************
New Features and Bugs fixed in WinMACCS 3.4 to create WinMACCS 3.6
************************************************************************
1. Comida2 would not run if a new comida2 input file was created. It was not possible for any
new WinMACCS projects where the Comida2 data were manually entered to have worked.
This problem was corrected.
2. Nonuniform bin sampling reports, were not available. This was corrected.
3. It was not possible to run the sample problem with a large numbers of simulations. The
file sipri.ini file (interface file to LHS) was modified to allow a larger problem size. The

algorithm that reads the binary file and put the binary file data into the project database
(i.e., the .mxd file) were modified. Now, only results requested by user are inserted into the
database. Sample problem Sampled Values LNT now runs for up to 1720 realizations.
4. Form that allows selection of cyclical files was modified to be more user friendly. Ability
to select multiple files (as opposed to only allowing one file at a time to be selected) for
addition or removal from the cyclical file set was implemented. This option is implemented
by using the right mouse click. Removal from the cyclical file list was extended to
include double clicking the file name to remove it from the list. Resizing of some forms
was implemented. If the form is widened, the list of selected files and folder view
portions of the form are also expanded. The form cannot be lengthened or lessened in
width.
5. The Meat/Milk Ingestion form was modified to have the same limits and the same look as
the other ingestion transfer forms.
6. WinMACCS can now be run in batch mode.
In this example, the command entered on a command line or batch file starts
WinMACCS and waits until WinMACCS has been closed before proceeding to the
next statement.
> start /WAIT "C:\Program Files\WinMACCS\winMACCS.exe"
“E:\WinMACCSSamp\inf_bin\inf_bin.mxd"
In this next example, WinMACCS opens the project inf_bin.mxd and runs it.
WinMACCS closes after the project has been run. The “-r” parameter directs
WinMACCS to run the project after it has opened.
> "C:\Program Files\WinMACCS\winMACCS.exe"
"E:\WinMACCSSamp\inf_bin\inf_bin.mxd" –r
If the –r option is used, a log file, AutoRun.log, is created in the project directory.
All error messages and warnings are written to this file.
7. The new version asks the user before deleting model1.out. All modelx.out where x is an
integer, are deleted from the \Output directory whenever MACCS2 is run from
WinMACCS. The user is now reminded of the presence of one or more of these file, and
is prompted with the choice of canceling the run or continuing.
8. The ability to enter uncertain dose conversion factors was added.
9. WinMACCS was integrated with Sandia specific Distributed Execution Framework (DEF)
software. However, this implementation is currently hidden from the user.
10. The variables that could be set to be uncertain were expanded as follows: PLHEAT,
PLHITE, PLUDUR, CORINV, IBDSTB, ISTRDY, ISTRHR, RNRATE, CYDIST,
CYCOEF, DURBEG, ALPHA. One variable was removed from the set that can be
uncertain: GENERATION.
11. Resolved problem reported as follows:
Within an output request, summary report sorts descriptions in alphabetical order. This
has the effect of some entries not being in expected ascending numerical order.
Example of out of order entries in the summary report as follows:
Evacuation Evac # 1 L-ICRP60ED TOT LIF [.9,1.1](km)

Evacuation Evac # 1 L-ICRP60ED TOT LIF [0.E+00,.1](km)
Entries are now displayed in the correct order.
12. Resolved problem reported as follows: If the \Input directory is missing from the project
directory and the user clicks the Run button, a misleading error message is generated.
Additionally, the ATMOS template file is not saved, and an unrelated parameter
modification form is opened. This makes it difficult for the user to diagnose the problem.
Now a warning message is displayed and the missing directory is created by WinMACCS.
13. When running a large problem an error is generated in WinMACCS as follows: "Cannot
open any more tables. Possible Software Bug from SortDescription.” The MACCS2
problem ran, but the summary report was not successfully generated. This problem was
related to a Microsoft library being used by WinMACCS. The algorithm was modified to
fix this.
14. Resolved problem reported as follows: Full project name is not shown in the title bar of
WinMACCS. In using version 3.4, when opening a project file by double clicking on the
.mxd file, an abbreviated name is shown in the WinMACCS main window title bar.
Abbreviated names were also displayed in the new project dialog box. Complete path and
full name is now displayed. This fix also repaired the following reported problem:
When running a project, MACCS2 displayed an error in reference to the record size of a
DCF file path/name. This error was misleading. The problem was that MACCS2 would
not run with a DCF file if WinMACCS was opened by double clicking on the .mxd project
file.
15. When running 2000 realizations, not all status checks (OK or NO followed by a MACCS2
error message) were reported in the Results windows. This is because there was a
software limit of 20000 characters allowed. This was increased to the maximum allowed
value of 65535. When this limit is reached, the box is cleared and the count restarted. To
conserve space, messages reporting successful simulation run (OK status messages) were
removed from the Results window. Negative messages (errors) were retained.
16. Resolved problem reported as follows: Modified File/SaveAs behavior. Contents of
Input and Output directories were copied to the project. Now, only the contents of the
Data directory are copied to the project. Empty Input and Output folders are created.
17. Added an option in the execute menu: Recover DEF Output. This allows the user to
recover DEF output in a situation where there is a problem with the automatic recovery of
the MACCS2 results by WinMACCS.
18. Resolved problem reported as follows: Correct variable descriptions, units and limits.
Corrections are as follows:
Changed units of RISTHR to dimensionless
Changed description of I1DIS4 as follows: Defines the spatial interval of the region
of interest. Risk is calculated for this radial ring.
Changed comment with respect to PATHNM as follows: Defines the names of the
pathways for which centerline doses are to be reported. If organ is Skin, pathway
is not used. In this case, any pathway can be selected.
Changed bounds of IANG_B and IHRDIR from [1,16] to [1,NUMCOR]
Changed the comment related to IHRDIR to the following: Defines the list of wind
directions that are used for a single trial. They are given as integers corresponding
to the compass directions starting with north (1) and moving in a clockwise
direction. The user must supply 120 values, one per hour.

Changed comment related to DURBEG to the following: This phase starts when
the first individual in the shelter and evacuation region begins to evacuate, which is
defined by the minimum over all i of DLTSHL(i)+DLTEVA(i) after the time
designated by REFPNT.
Changed the upper bound of CTHALF1, CTHALF2 and CTHALF3 from 1E14 to
3.15E13. Changed units of TGSBEG and TGSEND from dimensionless to Julian
day.
Changed upper bound of IHRDIR from [1,16] to [1,NUMCOR]
19. Resolved problem reported as follows: Form name ‘Dose by Grid Element’ changed to
‘Land Area Exceeding Dose’. Caption on this form changed to ‘Land Area Exceeding
Dose’. Description of variable PRINT_FLAG_C changed to ‘If True, then output includes
dose for all grid elements. If false then these detailed results are suppressed. Form name
‘Dose by Concentration’ changed to ‘Land Area Exceeding Concentration’. Caption on
this form changed to ‘Land Area Exceeding Concentration’ Description of variable
PRINT_FLAG_D changed to ‘If True, then output includes concentrations for all grid
elements. If False then these detailed results are suppressed.
20. Resolved problem reported as follows: Allow users to set their own directory for
WinMACCS. To resolve this problem, a file, WinMACCS.ini, was created. This file is
located in the program files directory.
This file contains the following line:
PROJECT_DIR "C:\WinMaccs Projects"
This file is editable by the user through usage of a text editor. The ability to retain
permissions to edit this file is up to the user. The rule is that the directory must
already exist. If it exists, than this directory is the user’s base directory.
If the file WinMACCS.ini is not present, then the old directory, X:\WinMACCS
Projects\ is the user’s base directory.
21. WinMACCS was modified to be friendly to non-DEF users. If database table, appsetting,
has field Distribute set to false, then Execute Advanced form does not show timer settings
labeled "Distributed Execution Framework Parameters".
************************************************************************
New Features and Bugs fixed in WinMACCS 3.6 to create WinMACCS 3.7
************************************************************************
1. When a user chose the “Create DCF File” and then changed to an ATMOS only run,
WinMACCS tried to populate the DCF template and failed because the template file
doesn't exist. Maccs2 does not run. This bug was fixed.
2. If the value of NUMCOR was changed from 16 sectors to 32 sectors, the network
evacuation and radial and network evacuation speed forms were incorrectly flagged as
defined, even though the values were defined for only for 16 sectors. These forms are
now flagged as undefined.
3. The SUMPOP option was integrated into WinMACCS. This allows a user to specify a
cohort population in a very general fashion. This option is activated from the Project
Properties window under the Site Data tab. If the radio button Create from Existing Site
File is selected, then WinMACCS creates a new site data file based on model input and an
existing site data file.
4. When running an EARLY only calculation with no site file, it was not possible to calculate

5.
6.
7.

8.
9.

type C or D results correctly. This is because the variable FRACLD is required but not
defined. The FRACLD variable used to be in the CHRONC/Regional
Characteristics/Land Usage form. This variable was moved from CHRONC to the
EARLY/Model Basis/Uniform Site Data form. It is required if a site file is not used.
Multi-select functions on Radial Evacuation Speed, Network Evacuation Direction, and
Network Evacuation Speed forms was implemented. This allows the user to select both
radii and sectors in a more general fashion.
New limits for the speed multiplier for all cohorts was modified to [.001,1000]. The
Radial Evacuation Speed and Network Evacuation Speed forms were affected.
Projects that used the option Create DCF File in WinMACCS 3.6 do not retain modified
DCF values when opened in a newer version of WinMACCS. These projects can be
repaired by the Sandia programming staff by request. DCF values entered in the current
version, 3.7, will be retained upon upgrades to later versions of WinMACCS.
When running a calculation with 596 uncertain variables, WinMACCS quit when trying to
create a report, SampleRank.out, causing the calculation to abort. This was due to an
Access database limit. This bug was fixed.
In previous versions, the name of the cyclical file used to create a specific realization was
not reflected in MACCS2 input or output. The name of cyclical file being used is now
appended as the initial line of the Problem Description field when this field is written to the
ATMOS input file. There is no change to any variable in the project file. The only
change is that the cyclical file name and path appears as a MACCS2 comment in the Atmos
input cards. This comment is also passed through to the MACCS2 output file.

************************************************************************
New Features and Bugs fixed in WinMACCS 3.7 to create WinMACCS 3.9
************************************************************************
1. The name MACCS2 was changed to MACCS.
2. "Phase Durations" and "Evacuee Travel Speeds" were combined into one form, Phase
Durations and Speeds. See section titled Combine Input Forms for Specified Parameters
in document WinMACCS Improvements.pdf.
3. WinMACCS would not run with very large monitors. This was fixed by replacing
calculations using 2-byte integer arithmetic with floating point arithmetic.
4. Resizing capabilities were added to forms displaying evacuation maps.
5. Resizing capabilities were added to parameter modification forms.
6. Optional units of measurement were added for WinMACCS parameters.
7. On the forms Radial Evacuation Speed, Network Evacuation Direction and Network
Evacuation Speed, the button to clear the form (shown with an eraser icon) that is usually
found to the right of the comment text box is missing. This button was added.
8. Form "Population by Cohort/Distributions Assigned", has a check box labeled "Hide
Map". If checked and a background map is shown, the map is hidden. This is done
correctly. However, if "Hide Map" is checked and the "Outer Ring Shown" or "Inner Ring
Shown" is changed, the map does not remain hidden. This was corrected.
9. When upgrading a sample project, the following error was reported:
Subscript out of Range

Unknown problem
Unable to complete shape and validation stage
This was triggered when a project had more than 32768 variables defined. This was fixed
by changing the index that referenced the variable array from a short to a long integer.
10. Changed wording on Population Distribution forms from “Distributions”, “Distribution
Labels”, and “Distributions Assigned” to “Populations”, “Population Labels” and
“Populations Assigned”.
11. Improved usability of map forms for inputting speed, evacuation direction, and population
values per grid element.
12. Expanded copy/paste functionality in parameter modification forms. See WinMACCS
Improvements.pdf for a more detailed description.
13. Added a new menu item Edit/Auto Propagate Cohort Values on the main menu. By
default this will be checked (turned on). When the user changes values on a cohort type
form, the values propagate to subsequent cohort forms until the next form is found where
they are already defined.
14. If rank orders are defined (Edit/Correlate Uncertain Variables/Enforce Rank Order) for
variables in models that are not used (example: ATMOS is only model, but there are some
Rank orders defined for EARLY variables) there was a warning message generated for
each of these entries. This message was removed.
15. A button was added to clear all entries from the Rank Correlation form.
16. If the Dose tab was incomplete on the Properties form and the user did not select the
EARLY model, MACCS would not run. This is an error because the Dose settings are not
used when the EARLY model is not selected. This was fixed.
17. The population fraction using the KI Model when the annual dose threshold (AT) or
piecewise linear threshold (PL) models are on must be either 1 or 0 (i.e., either the entire
cohort takes KI or does not take KI). The KI Model value for the linear no threshold
(LNT) model is in the range [0,1]. The KI Ingestion form used for the AT and PL models
was moved from the Dose Model category to the Emergency Cohort One category. There
are now two KI Ingestion forms in the Emergency Cohort One category, namely KI
Ingestion Linear No Threshold and KI Ingestion Threshold or Piecewise. Values set now
correctly propagate to other cohort forms. Additionally, the acceptable input values of
population (0 or 1 for AT and PL models, and the range [0,1] for LNT model) is now
correctly enforced for all cohorts.
18. Additional custom output reporting options were added. See WinMACCS
Improvements.pdf.
19. A Keyhole evacuation model was added as an option. See WinMACCS
Improvements.pdf.
20. Optional Population Movement results can be requested by the user. See WinMACCS
Improvements.pdf.
21. The user was not able to cancel a project upgrade when opening a project with previous
versions of WinMACCS. This was corrected by adding a cancel button to the Upgrade
Database form.
22. Enforced the requirement that when the multiplier model is selected, IPLUME=3 is the
only choice allowed. This was not true in the previous version.
23. When upgrading from an older project with exposed radionuclides, the data file links on

the Project/Files tab were not correctly imported. This was fixed.
24. If the user modified the population in the site file after linking the file to WinMACCS, an
inconsistent site file was created by WinMACCS when using the SUMPOP option. The
site file is now validated when the user clicks the Run button when the SUMPOP option is
on. The following are validated:
• The number of wind directions on the site file is consistent with the WinMACCS
value.
• The shape of the population array in WinMACCS is consistent with the number of
radii and the number of wind directions on the site file.
• The values in the population array in WinMACCS are equal to the values in the site
file up to a round-off error.
• As an additional aid to the user, the form that shows the project population values
automatically opens if validation fails.
25. Precision was being lost when creating the site file in WinMACCS. WinMACCS was
using an exponential format for populations greater than or equal to 10,000,000. This was
corrected.
26. When selecting the SUMPOP model and the number of cohorts was set to one, only one
population was written to the created site file, as expected. However, instead of using the
keyword POPULATION1, the keyword POPULATION was used. This caused MACCS
to fail because the SUMPOP option was on. The code was modified to correct this error.
27. The cross validation of variables that were modified was not working as expected. In a
sample problem, when NUMRAD was reduced from 26 to 5, the Health Effect Cases form
shown in the Project/Parameters tab window should have been listed the optional error
symbol (i.e., solid yellow crossed diamond) because the form referenced radii greater than
five. Instead the form was not shown to be in error (i.e., the yellow diamond symbol was
not crossed). This was corrected.
28. Under certain circumstances, model Population by Cohort should have been displayed
with a grey icon indicating that this form is not used in the calculation instead of a green or
red icon. This was corrected.
29. If a new site file is linked, it is now required that the spatial grid in WinMACCS (variable
SPAEND) is consistent. The user is asked “Do you want to upgrade to be consistent with
the site file?” If the user selects “No” then the save operation is canceled and the form
“Specify Site Population Data File” remains open. The radii specified in the site file must
be imported into the WinMACCS variable SPAEND if the site file is to be linked with the
project.
30. The maximum number of chemical groups was increased from 20 to 150. If the user
desires, every radionuclide can be treated as a chemical group with its own release fraction.
31. When cyclical files had the extension .inp and the option to "delete input files" was
selected, MACCS failed after the first execution because the remaining .inp files were
deleted. This was corrected.
32. A user using a computer set to use Asian symbols reported not being able to use LHS
within WinMACCS. The problem was that some special characters that WinMACCS
inserted into files to mark positions for sampled values were being removed by the user’s
operating system or other user software. It was also discovered that the special character
used to insert file names, in particular the DCF file name and the Comida2 file name, were
also inadvertently removed. This problem was solved by allowing the user to modify the

default delimiter defined in the WinMACCS.ini file giving the user the ability to change
the delimiter to an ASCII character that is compatible with his/her software.
Sample WinMACCS.ini file:
PROJECT_DIR "C:\WinMACCS Projects"
UNCERTAIN_MARKER 165
FILE_MARKER 166
In this file, value 166 for FILE_MARKER indicates that the ASCII character value 166 is
used to mark the place where the file path is to be inserted in the template file. Similarly,
UNCERTAIN_MARKER marks the place where a LHS value is inserted.
33. A new menu option, Execute/Monte Carlo Simulation was added to the interface. If this
is not checked, then LHS sampling is used. This setting persists when the project is saved.
34. When importing a MACCS input file with no values associated with an output type
variable (e.g., NUM0 = 0), zero was assigned to the variable. The WinMACCS form was
shown as being in error. To correct this, the user had to set the form to its default settings
or open the form and click on the OK button. The form no longer shows an error
condition under these circumstances.
35. The WinMACCS user is required to enter names for each of the chemical groups in the
form ATMOS/Radionuclides/Chemical Names. In previous versions of WinMACCS,
these names were inserted as comment cards in the ATMOS input file. This was modified
to enter the chemical group names as ATMOS variables. Now when importing an
ATMOS input file created by WinMACCS in a new project, these values are read into the
project. The user no longer has to manually reenter the chemical group names in
WinMACCS.
36. The upper bound of NUMC was changed from 16 to 40.
37. Variable POPCST was moved from the Chronc/Interdiction Costs form to the
Chronc/Compensation Costs form.
38. Form margins that were too small under Windows 7 to see scroll bars, etc. This was fixed.
39. The number of plume segments was increased from 200 to 500.
40. When opening an earlier project in WinMACCS the form to specify the site file was
flagged with a crossed red hexagon indicating that it is Undefined or an Error, even if this
file was specified correctly. This was corrected.
41. When running a threshold calculation, the file ChrndfFactors.bin is created in the project
\Data folder. This file is large (approximately 200 megabytes) and is not needed after the
calculation is completed. WinMACCS was modified to delete this file after the simulations
are finished.
42. When opening an earlier project in WinMACCS that contains more than one cohort, many
cohort variables were undefined. The source of this difficulty is that in version 3.9.0 the
specification of cohort values was changed from optional to required. An option was
added on the File menu, "Propagate Cohort Values on Upgrade". By default this is set to
true. If this option is true, the cohort values are propagated to cohorts when the older
project is opened and the problem with undefined cohort values is eliminated.
43. In previous versions, binary files and the model input data stored in the project database
could be out of sync. This could be caused by a user not saving his project file

modifications. This was partially addressed by asking the user the following question
before running Maccs: "Do you want to save the project changes?" The default answer is
“Yes.” However, this default can be changed to No by including the following line in the
WinMACCS.ini file:
DEFAULT_SAVE_ON_RUN FALSE.
Additionally, it was discovered that the user is not prompted to save the project after the
project reads in the binary results files. This was corrected.
44. When running a test problem using a cyclical file set, it is only possible to calculate data
summaries for the report summary.txt if the variables to be reported are present in all of the
binary files. If this is not the case, the message displayed in file summary.txt does not
contain sufficient details to allow a user to identify which file does not contain the required
variables. For example, the message “Unable to Calculate Grand Mean. Expected 6 runs.
Found 5” does not indicate which of the six files are lacking. The message was modified
to indicate the run that had missing data as follows: "Unable to calculate. Missing data
from run(s) 3.”
45. Contents menu option was removed from the Help menu. On-line help is not supported in
WinMACCS under Windows 7.
46. Remove error message displayed when starting WinMACCS and folder C:\WinMACCS
Projects referenced in the WinMACCS.ini file is not found. This was confusing because
the first time WinMACCS is executed, the folder is created. However the error message
is displayed before the creation of the folder C:\WinMACCS Projects.
47. Implemented a dirty bit in the evacuation forms, namely Network Evacuation Direction,
Network Evacuation Speed, and Radial Evacuation Speed. These changes were also
implemented in the population map form, Populations Assigned. If the user clicks the X
and the form has changed, the following question is asked, “Do you want to save changes?”
This allows the user the opportunity to save the data entered on this form.
48. If MACCS is run with duplicate output requested, WinMACCS generates an error message
an excessive number of times as follows: “Warning: The changes you requested to the
table were not successful because they would create duplicate values in the index, primary
key, or relationship.” The error messages were compressed to a single error message that
gives a count of the number of binary file variables that were not saved.
49. WinMACCS previously expected a blank line to be at the end of the site file. This
requirement was eliminated.
************************************************************************
New Features and Bugs fixed in WinMACCS 3.9 to create WinMACCS 3.10
1. The multi-source model was implemented. This model supports MelMACCS version
1.7.3 and later output files.
2. Bounds were increased for variables OALARM (2592000 s), PDELAY (2592000 s),
ENDEMP (3456000 s), TIMHOT (3456000 s), TIMNRM (3456000 s), DLTSHL
(3456000 s), and DLTEVA (3456000 s).
3. Dose projection variables, DPPEMP (EARLY) and DPP_INTERPHAS (CHRONC), were
added in order to implement user-definable dose projection periods.
4. A new output type 14 was added to calculate the number of people that evacuate and
relocate during each phase.

5. A new EARLY variable, TIMRTN, was added to specify the evacuee return time for
people in the evacuation zone not directly affected by any plume segment.
6. All custom report definitions were lost when upgrading a project from an earlier version.
This was fixed. The process of defining custom reports was improved to ensure that
custom reports are uniquely named. The process of creating custom reports was made more
robust when some results referenced in the reports are unavailable.
7. The ability to copy report definitions from a different project to the current project was
implemented. A new menu item was added, namely File/Import Custom Report
Definitions.
8. The form EARLY/Model Basis/Cohort Units was not updating the units properly if the
user had a cohort variable form open then opened the Cohort Units form, changed the units,
clicked OK, and then clicked OK in the cohort variable form. This was resolved by not
allowing the user to change the cohort variable units when the Cohort Units form is open.
9. Database tables containing simulation results read from the MACCS binary files were
removed from the project database and moved to external files. This allows larger
problems to be run and improves post-processing performance.
************************************************************************
Known Bugs and Puzzling Features
************************************************************************
1. The variable defining the emergency-phase dose projection period, DPPEMP, has an
effective upper limit of seven days even though the interface allows larger values.
2. There are some variables in MACCS input that are not directly available in WinMACCS.
The values of these variables are determined by user input in the WinMACCS Properties
form. For example, in the ATMOS model METCOD, ENDAT1, and ENDAT2 are
visible as read-only variables in the parameter modification forms. Read-only variables
have a grey instead of a white background within the Parameter Modification windows.
3. There are some variables in the WinMACCS input that do not exist in MACCS. For
example, GRPNAM is a vector containing names of chemical groups. This vector is used
to label the variables RELFRC, DRYDEP, and WETDEP. Even though GRPNAM is not
used in MACCS, it is a required input variable in WinMACCS.
4. The grid copy/paste operation for 'uncertain' values isn't implemented. If the user does a
copy/paste of an uncertain value, the characters "Uncertain" are pasted into the grid. This
error is caught by data validation.
5. At this time, functional bounds (in other words, the bound is not simply a constant or the
value of a variable but a function of the value of a variable) are not implemented as part of
the variable validation in WinMACCS. However, the correct bound is shown in the
description area of the parameter modification form. This is true for other variables that
have functional upper bounds, and variables that have either functional lower bounds or
lower bounds that are dependent on the value of a variable. An example of this is that the
upper limit for variable LASMOV is a function, i.e., NUMRAD-1. The upper bound is
shown to be NUMRAD on the parameter modification form. This is not correct.
However, the upper bound of NUMRAD - 1 is correctly described in the parameter
definition on this form.
6. ATMOS change cards are not supported in WinMACCS. However, this option can be

emulated by using the MACCS Cyclical File function.
7. If latent cancer, early fatalities, or injuries are turned off from the Properties form, Early
Effects tab, some output requests may be invalid. WinMACCS does not detect this
problem but MACCS reports an error.
8. The new model to account for the effect of precipitation on evacuation speed may not
always work as expected. At the time that an evacuee enters a grid element, a calculation is
made to determine the residence time in that grid element. This calculation is based on the
travel speed at the instant that the evacuee enters the grid element and does not account for
possible changes in speed as he/she moves through the grid element (e.g., a change in
precipitation condition that would cause the evacuee to move faster or slower).
9. The draft version of the WinMACCS Users' Guide (Version 3.4) is out of date with the
current version of WinMACCS (Version 3.9). Additional documents have been included
with the installation describing how to features added after Version 3.4. These documents
are available
10. Not all results are available when selecting PostProcessing/Graphical Results/Results over
all Weather Trials. This is by design and is a temporary solution to a software limit. A
project can’t exceed 2 gigabytes in size. If this is exceeded, WinMACCS will fail. To
prevent this, only the data that the user has requested to be placed on report or a MACCS
output ccdf in the WinMACCS interface is available on this form. To work around this
problem, the user can cause the data to be read into the project and be available in the
Results over all Weather Trials forms by creating a custom report that references the data
of interest. This can be done by using the Post Processing/Report Results/Manage
Custom Reports feature.
11. There is no on-line help available. This was dropped because Microsoft no longer
supports the help file format previously used. This will be corrected in future versions.
For problems with installing or using WinMACCS, you can send an
email to nbixler@sandia.gov or klmcfad@sandia.gov or you can contact
Nate Bixler by phone at (505)845-3144.
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